ClassLive Pro
Available through eCollege
Student Version

powered by
Blackboard collaborate

Version 12.5.2.7154-g4f72f02

Loading...

Copyright (c) 2006-2012 by Blackboard Inc. All rights reserved. Blackboard, the Blackboard logo, and Blackboard Collaborate, are trademarks or registered trademarks of Blackboard Inc. or its subsidiaries in the United States and/or other countries. Blackboard products may be covered by one or more of the following U.S. patents: 7,453,395, 7,086,853, 7,310,278.
# Table of Contents

**ACCESS CLASSLIVE**.................................................................................................................. 4

**WINDOW**.................................................................................................................................. 5

**MENUS**..................................................................................................................................... 7
  * Drop-Down Menus....................................................................................................................... 7
  * Option Menus............................................................................................................................... 7
  * Participant Interactive Menus...................................................................................................... 7

**AUDIO**..................................................................................................................................... 8
  * Microphone Activated.................................................................................................................. 9
  * Permission Indicators................................................................................................................ 9
  * Status Indicators........................................................................................................................ 9
  * Audio Setup Wizard................................................................................................................... 9
  * Use Microphone........................................................................................................................ 12
  * Adjust Microphone Levels......................................................................................................... 12
  * Adjust Speaker Levels............................................................................................................... 13

**VIDEO**.................................................................................................................................... 13
  * Audio/Video Window................................................................................................................. 14
  * Activity and Permission Indicators.......................................................................................... 14
  * Status Indicators....................................................................................................................... 15
  * Preview Video........................................................................................................................... 15
  * Transmit Video.......................................................................................................................... 15
  * Stop Video Transmission.......................................................................................................... 15
  * Select Video Camera................................................................................................................ 16
  * View Video............................................................................................................................... 17

**PARTICIPANTS PANEL**.......................................................................................................... 17
  * Participants Panel Components............................................................................................... 17
  * Moderator Privilege................................................................................................................... 18
  * Grant Participants Moderator Privilege.................................................................................... 18
  * Raise/Lower Hand..................................................................................................................... 19
  * Raise/Lower Hand..................................................................................................................... 19
  * Raised Hand Notification.......................................................................................................... 19
  * Step Back................................................................................................................................ 20
  * Step Away................................................................................................................................. 20
  * Step Back................................................................................................................................ 20

**CHAT**..................................................................................................................................... 20
  * View Chat Messages................................................................................................................ 21
  * Conversation Tabs..................................................................................................................... 22
  * Move Between Conversations................................................................................................. 22
  * Send Chat Messages................................................................................................................ 22
  * Send Messages to Everyone in Room or Existing Group Conversation.................................... 22
  * Send Messages to Selected Individuals................................................................................... 22
  * Add Emoticons to Chat Message............................................................................................. 23
  * Add External Links to Chat Message....................................................................................... 24
  * Enter Feedback......................................................................................................................... 24
CONTENT AREA MODES .................................................................................................................. 25
  SWITCH MODES ................................................................................................................................. 25

WHITEBOARD MODE ......................................................................................................................... 26
  WHITEBOARD TOOLS PALETTE ........................................................................................................... 26
  ADD EXTERNAL CONTENT .................................................................................................................... 28
    Supported Content Types ................................................................................................................ 28
    Insert Content ................................................................................................................................. 28
  INSERT TEXT ...................................................................................................................................... 29
    Use the Simple Text Tool .................................................................................................................. 29
    Use the Text Editor Tool ................................................................................................................... 30
  INSERT EXTERNAL LINKS .................................................................................................................... 30
  INSERT GRAPHICS .............................................................................................................................. 31
  INSERT CLIP ART IMAGES .................................................................................................................. 32
    Insert Clip Art Background Image .................................................................................................. 32
    Insert Clip Art Image as Stamp ....................................................................................................... 32
  INSERT SCREEN CAPTURE ................................................................................................................... 32

POINT TO ITEMS ON WHITEBOARD ................................................................................................ 33

APPLICATION SHARING .................................................................................................................... 33
  VIEW SHARED APPLICATION ............................................................................................................. 34
    Scale Shared Content ....................................................................................................................... 34
    Maximize Content Area .................................................................................................................... 34
  HOST APPLICATION SHARING SESSION ....................................................................................... 34
    Switch to Application Sharing Mode .............................................................................................. 34
    Start an Application Share .............................................................................................................. 35
    Pause Application Share ................................................................................................................ 36
  RESUME APPLICATION SHARE ....................................................................................................... 36
  PREVIEW APPLICATION SHARE ...................................................................................................... 36
  GIVE CONTROL TO ANOTHER PARTICIPANT ................................................................................... 36
    Delegate Remote Control ............................................................................................................... 36
    Grant Request for Control .............................................................................................................. 37
    Stop an Application Share .............................................................................................................. 37

WEB TOUR ......................................................................................................................................... 38
  SWITCH TO WEB TOUR MODE ........................................................................................................... 38
  START WEB TOUR ............................................................................................................................. 39
  CONDUCT WEB TOUR ....................................................................................................................... 39
  FOLLOW ME OPTION ......................................................................................................................... 39
  TOUR GUIDE CONTROL ..................................................................................................................... 39
  PUBLISH URL/ADDRESS TO CHAT PANEL ...................................................................................... 40
  STOP WEB TOUR ............................................................................................................................... 40
  VIEW A WEB TOUR ............................................................................................................................ 40
  OPTIMIZE CONTENT AREA .............................................................................................................. 40
ACCESS ClassLive

- Click the Live tab on the Tools Menu.
- Select the ClassLive tab when the Live window displays.

- Click the Join Session link.
- The Java window will display indicating the program is loading.
- The Starting Application window will display and then a Security Warning window.

- Click the Run button.
- The ClassLive Pro window and then another Security Warning window should display as shown in the illustrations on the next page.
Click one of the options in the **Security Warning** window.

A **Connection** message will display indicating the progress of the upload (see above).

The program should finish loading and the **ClassLive** window should display.

For information on the **ClassLive** window, see the pertinent documents on the **ClassLive Web Page**.

**WINDOW**

This window consists of six main components. These include the menu bar, the Audio and Video panels, the Participants panel, the Chat panel, the Collaboration toolbar, and the main context area. The main Content Area displays the Whiteboard, Application Sharing, and Web Tour. Each of these main components are described in the table below.

<table>
<thead>
<tr>
<th><strong>Component</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Bar</strong></td>
<td>This bar contains the File, Edit, View, Tools, Windows, and Help Menus.</td>
</tr>
<tr>
<td><strong>Audio and Video Panel</strong></td>
<td>This panel enables the student and faculty member to participate in conversations using either a microphone and speakers or a teleconference. Video can also be transmitted and received during the session. The video can be previewed before transmission.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Participants Panel</td>
<td>This panel provides a list of the participants and moderators for the session. Information about each participant and moderator are shown in this panel. A small toolbar appears at the top of this panel which contains buttons for raising your hand, stepping away from the session, and a menu for selecting polling responses.</td>
</tr>
<tr>
<td>Chat Panel</td>
<td>This panel is used to send Chat messages. Messages may be sent to all participants or to the moderator only. Private Chat messages can be sent by selecting an individual participant from the list. Messages can be printed and saved to track session communication.</td>
</tr>
<tr>
<td>Collaboration Toolbar</td>
<td>This toolbar contains three buttons that are used to switch between three content modes in the Content Area; Whiteboard, Application Sharing, and Web Tour.</td>
</tr>
<tr>
<td>Content Area</td>
<td>This area is the Main Presentation window. The area can be used by moderators to load presentations. All participants can use the tools on the Whiteboard to draw or write unless they have been disabled by the Moderator. All the objects used in this area are dynamic and can be modified. All participants can print or save the Whiteboard pages, unless the Whiteboard has been protected.</td>
</tr>
</tbody>
</table>
Most of the functionality for this program can be accessed through the Menu structure. In addition, it is possible to use keyboard shortcuts, or icons to access the commands. This table explains each of the menu structures.

<table>
<thead>
<tr>
<th>Tools</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Menu</td>
<td>This menu contains commands for working with Whiteboard files. Commands such as New, Open, Save, Print, and Exit can be found under this Menu item.</td>
</tr>
<tr>
<td>Edit Menu</td>
<td>To make editing changes to items within ClassLive, select this Menu option. Commands such as Cut, Copy, Paste, Select All, and Preferences can be found when this Menu is selected.</td>
</tr>
<tr>
<td>View Menu</td>
<td>Select this Menu to access commands that can be used to change the window layout or to change control modes. The commands Show Sidebar, Whiteboard, Application Sharing, Web Tour, and Restore Default Layout are available under this Menu.</td>
</tr>
<tr>
<td>Tools Menu</td>
<td>This Menu contains sub-menus for working with the various tools in ClassLive. These include Application Sharing, Audio, Chat, Interaction, Polling, Profile, Video, and Whiteboard.</td>
</tr>
<tr>
<td>Window Menus</td>
<td>To open the Activity, Closed-Captioning, File Transfer Library, Graphing Calculator, and Notes.</td>
</tr>
<tr>
<td>Help Menus</td>
<td>Select this Menu to access documentation regarding ClassLive. Keyboard Shortcuts, Accessibility Guide, Essentials for Participants, the On-Demand Learning Center, Diagnostics, Join or Leave a Session.</td>
</tr>
</tbody>
</table>

Drop-Down Menus
There are a number of drop-down menus available throughout the interface in addition to the ones available in the Main Menu Bar.

Option Menus
- Most of the modules within the ClassLive interface have their own Options Menu.
- These menus give the Moderators and Participants quick access to commands that are specific to those modules.
- To open an Options Menu, click the Options Menu with the mouse.

Participant Interactive Menus
- Two drop-down menus are available in the Participants Menu.
- These menus enable Participants to enter feedback and responses.
- These menus include the Emoticons Feedback Menu and the Polling Response Menu.
- Whatever is selected from these Menus will be displayed in the Participants List next to the Participants Name.
Everyone in the Session will be able to view the information unless the Moderator turns off the viewing feature. These Menus will open automatically when the mouse is moved over them.

### Audio

With this feature, Participants can participate in a conversation with other Participants during a Web Conferencing Session using Voice over Internet Protocol (VoIP). For the session, the Participant needs access to a microphone and speakers or headset. This feature is not available for use on Mobile devices. The Audio panel is shared with the Video panel. The table and illustration below show the components that are relevant to the Audio Panel.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Setup Wizard Button</td>
<td>This button can be used to setup the Audio feature. When the button is selected, the Audio Setup Wizard window will display.</td>
</tr>
<tr>
<td>Expand/Collapse Button</td>
<td>This button is used to expand or collapse the Audio and Video Panel.</td>
</tr>
<tr>
<td>Microphone Level Indicator and Slide</td>
<td>To increase or decrease the level of the microphone, slide the bar forward and backward.</td>
</tr>
<tr>
<td>Options Menu</td>
<td>To make changes to the setup of the Audio/Video window, select this button.</td>
</tr>
<tr>
<td>Primary Video Display</td>
<td>This is the area where the video displays. When another Participant is talking, their profile picture and name will display in this area.</td>
</tr>
<tr>
<td>Speaker Level Indicator and Slider</td>
<td>To specify the sound level for Participants who are speaking, move the slider back and forth.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Talk Button</td>
<td>Press this button to talk with other Participants in the session.</td>
</tr>
</tbody>
</table>

**Microphone Activated**
The blue Audio Button shown at the right, indicates that a Participant has their Microphone turned on. This button will appear next to their name in the Participants Panel. The display panel will display the Participants Name when the Talk feature is activated. The Primary Video Display Panel will display the Participants Name.

**Permission Indicators**
The state of Audio activity and permissions can be monitored through the indicators displayed in the Participants List of the Participants Panel. The table below describes the icons that are displayed in the Participants List to indicate Moderator and Participant permissions and activity while using Audio.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Microphone icon]</td>
<td>The microphone has been turned on by the Moderator or Participant.</td>
</tr>
<tr>
<td>![Microphone icon with globe]</td>
<td>This icon indicates that Audio permission has been set globally to <strong>ON</strong> but the Moderator has revoked Audio permission from the Participant.</td>
</tr>
<tr>
<td>![Microphone icon with globe]</td>
<td>The Moderator has set Audio permission globally to <strong>OFF</strong> but Audio permission has been granted for this Participant.</td>
</tr>
<tr>
<td>![Microphone icon with globe]</td>
<td>When this icon displays, it indicates that the Participant is running the Audio Setup Wizard.</td>
</tr>
</tbody>
</table>

**Status Indicators**

These indicators appear in the **Video Activity Indicator** icons of **Audio Users** in the **Participants List** when there are delays in the transmission or receipt of the Video. The degree of delay is indicated by color as explained below.

- **Amber Indicator** – This color will appear when a Participant’s receipt of audio is moderately delayed.
- **Red Indicator** – This indicator will appear when a talker or listener experiences a significant delay and may be offline from the session.
  - When this color appears, it could indicate a problem with the network connection.
  - It will often be followed by the Participant being disconnected from the session.

**Audio Setup Wizard**

This tool can be used to verify that the Audio is set up correctly. The Wizard is comprised of a series of panels that walk the Participant through the steps of selecting the proper settings for the microphone. It also is used to select the proper settings for the speaker and to set the speaker and microphone volumes. It is suggested that the wizard be run prior to the start of a session just to make sure everything is working properly. The instructions below explain how to use the Audio Setup Wizard on a Windows machine. For information on setting up the microphone and speakers on a Mac computer, see the user’s guide.

- To run the **Audio Setup Wizard**, complete one of the steps below.
  - Click the **Audio Setup Wizard** button at the top of the **Audio and Video Panel** (see illustration at right).
  - Click the **Tools Menu**, select **Audio**, and then select **Audio Setup Wizard**.
Click the Audio and Video Options Menu and then select Audio Setup Wizard.
The Audio Setup Wizard window will display (see illustration next page left).
Select the Audio Output Media Device connected to your machine.
Click the OK button.
The Speaker Setup window will display (see illustration next page right).
Click the Play button to adjust the Speaker to a suitable volume.

Click the Stop button to display the next options.
The Speaker Setup Confirmation window will display (see illustration below right).
Do one of the following:

☆ Click Yes if the volume is suitable.
  ✷ You will go to the next step in the setup.
  ✷ This is the step where the Audio Input Device will be selected.
☆ Click No.
  ✷ You will be prompted to Try Again or to Cancel.
  ✷ Click Try Again to go back to the previous step.
  ✷ Click Cancel to exit from the Audio Setup Wizard.

The Select Audio Input Device window will display (see illustration previous page right).
Select the Audio Input Device (microphone) that is connected to your computer.
Click the OK button.
The Microphone Setup window will display (see illustration below left).
Click the Record button and record a message.
The Microphone Playback window will display (see illustration below right)
When the Microphone has finished playing back the message the Microphone Setup Confirmation window will display (see illustration above left).

☆ If Yes was selected, the Setup Complete windows as shown in the illustration on the previous page will display.

☆ If No was selected, click the Try Again button to try the setup again.

Click OK to finish the process.

Use Microphone
Participants can turn on the Microphone using one of the methods shown in the list.

Turn Microphone On
笛 Click the Talk button in the Audio and Video Panel (see illustration at right).
笛 On a Windows computer, use the keyboard shortcut Ctrl + F2.
笛 On a Mac computer, use the keyboard shortcut Command-F2.

Turn Microphone Off
笛 The Microphone can be turned off by completing one of the three options below.

☆ Click the Talk button in the Audio and Video Panel.
☆ On a Windows computer, use the keyboard combination Ctrl + F2.
☆ On a Mac computer, use the keyboard combination Command-F2.

笛 When the Microphone is turned off, just the word Talk will appear on the button (see below).

笛 When the Microphone is turned on, a Microphone image will appear next to the word Talk (see below).

Adjust Microphone Levels
Moderators and Participants have the ability to adjust the volume of their Microphones. This can be done in one of four ways (Audio and Video Panel, Options Menu, Tools Menu, and Keyboard Shortcuts) as shown in the table below.

<table>
<thead>
<tr>
<th>Adjustment Option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio and Video Panel</td>
<td>☐ Click the Microphone Level Slider in the Audio and Video Panel as shown in the illustration above.</td>
</tr>
<tr>
<td></td>
<td>☐ Drag the slider to the right to increase the volume level.</td>
</tr>
<tr>
<td></td>
<td>☐ Drag the slide to the left to decrease the volume level.</td>
</tr>
</tbody>
</table>
Adjust Speaker Levels

In the same way, Participants have the ability to adjust the volume of the Speakers. This can be done in one of four ways (Audio and Video Panel, Options Menu, Tools Menu, and Keyboard Shortcuts) as shown in the table below.

<table>
<thead>
<tr>
<th>Adjustment Option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio and Video Panel</td>
<td>Click the Speaker Level Slider in the Audio and Video Panel as shown in the illustration on the previous page. Drag the slider to the right to increase the volume level. Drag the slide to the left to decrease the volume level.</td>
</tr>
<tr>
<td>Options Menu</td>
<td>Select the Audio and Video Options Menu. Select Adjust Speaker Level Up to increase the volume level. Select Adjust Speaker Level Down to decrease the volume level.</td>
</tr>
<tr>
<td>Tools Menu</td>
<td>Click the Tools Menu. Select Audio from the list of options. Select Adjust Speaker Level Up to increase the volume level. Select Adjust Speaker Level Down to decrease the volume level.</td>
</tr>
<tr>
<td>Windows Keyboard Shortcut</td>
<td>Press Ctrl + Up Arrow to increase the volume level. Press Ctrl + Down Arrow to decrease the volume level.</td>
</tr>
<tr>
<td>Mac Keyboard Shortcut</td>
<td>Press Command-Up Arrow to increase the volume level. Press Command-Down Arrow to decrease the volume level.</td>
</tr>
</tbody>
</table>

VIDEO

This feature enables Participants to transmit and receive video broadcasts with others in a session. A video broadcast is video that is sent live using a web cam. Up to six simultaneous camera transmissions can be displayed at one time.

NOTE:
- This feature should not be confused with a pre-recorded video/movie. These videos/movies can be played using the Multimedia feature.
Video broadcasts are not supported on mobile devices.

Audio/Video Window
The following components are available in the Audio/Video window. An illustration of the Video Panel appears below.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand/Collapse Button</td>
<td>This button is used to expand or collapse the Audio and Video Panel.</td>
</tr>
<tr>
<td>Options Menu</td>
<td>To make changes to the setup of the Audio/Video window, select this button.</td>
</tr>
<tr>
<td>Primary Video Display</td>
<td>This is the area where the video displays. The Participant’s Name also will appear in this area.</td>
</tr>
<tr>
<td>Preview Video Button</td>
<td>Select this button to preview what the video will look like. It is a good idea to preview the video before transmitting it to the Participants.</td>
</tr>
<tr>
<td>Transmit Video Button</td>
<td>Use this button to send the video to the other Participants.</td>
</tr>
</tbody>
</table>

Activity and Permission Indicators
The state of Video activity and permissions can be monitored through the indicators displayed in the Participants List of the Participants Panel. The table below describes the icons that are displayed in the Participants List to indicate Moderator and Participant permissions and activity while using Video.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>📺</td>
<td>The Video camera has been turned on by the Moderator or Participant.</td>
</tr>
<tr>
<td>🛑</td>
<td>This icon indicates that Video permission has been set globally to <strong>ON</strong> but the Moderator has revoked Video permission from the Participant.</td>
</tr>
<tr>
<td>🛑</td>
<td>The Moderator has set Video permission globally to <strong>OFF</strong> but Video permission has been granted for this Participant.</td>
</tr>
</tbody>
</table>
Status Indicators
These indicators appear in the Video Activity Indicator icons of Video Users in the Participants List. They display when there are delays in the transmission or receipt of the Video. The degree of delay is indicated by color as explained below.

- **Amber Indicator** – This color will appear when a Participants receipt of transmission is moderately delayed.
- **Red Indicator** – When a Participant’s receipt or transmission of Video is significantly delayed, this color will appear.
  - When this color appears, it could indicate a problem with the network connection.
  - It will often be followed by the Participant being disconnected from the session.

Preview Video
- Before a Video is transmitted to other Participants, it is a good idea to Preview it first in order to check the quality of the Video.
- If the Video is not satisfactory, it may be necessary to adjust the Webcam settings.
- To preview the Video, click the Preview button as shown in the illustration at the right.
  - When this button is activated, it will turn blue.
  - The images will display in the Primary Video Display along with the word Preview.
  - None of the other Participants will be able to see the Video.
  - If this button is not accessible (grayed out), it may mean one of the following:
    - A Moderator has removed the Participants access to the Video.
    - The number of simultaneous cameras (6) has been reached.
- If the Audio and Video Panel is collapsed, it will open automatically when a Video is previewed or transmitted.
- If an error appears when the Moderator or Participant tries to view a Video, one of the following could be the reason:
  - The camera could be in use by another application.
  - The correct camera is not selected under Preferences.

Transmit Video
- When a Video is being transmitted, the icon shown at the right will appear next to the Participant’s Name.
- Do one of the following to transmit Video to all the Participants.
  - Click the Transmit Video button in the Audio and Video Panel (see illustration at right).
  - On a Windows computer, use the keyboard combination Ctrl + F3.
  - On a Mac computer, use the keyboard combination Command-F3.
- When the Video is activated, a red camera will display on the Video button as shown in the illustration on the right.

Stop Video Transmission
To stop the transmission of a Video, do one of the following:
- Click the Video button in the Audio and Video Panel.
- On a Windows computer, use the keyboard combination Ctrl + F3.
- On a Mac computer, use the keyboard combination Command-F3.
Click the Preview button on the Audio and Video Panel.
- The Video will continue to display for the Moderator or Participant who was displaying it.
- Other Participants in the session will not be able to view the Video.

**Select Video Camera**
If a Participant only has one camera installed on the computer, that one is automatically used. If more than one camera is installed, then you must complete one of the steps below to select the device to be used using the Preferences window.
- Do one of the following to open the Preferences window.
  - On a Windows computer, click the Edit Menu and then select Preferences.
  - On a Mac computer, on the Web Conferencing Menu, select Preferences.
  - On a Windows computer, use the keyboard combination Ctrl + Comma.
  - On a Mac computer, use the keyboard combination Command-Comma.
- The Preferences window will display (see illustration below).

In the left pane of the window, select Camera Settings under Audio/Video.
In the Select the camera to use list, select the desired camera.
Select any of the other desired options.
Click the OK button to save the Preferences.
Click Apply to save the changes without closing the Preferences window.
Click Cancel to exit the Preferences window without saving the changes.
Any changes made under Preferences will remain for all other sessions until they are changed again.
**View Video**
To view a Video that is displayed by other Participants, the Primary Video Display must be opened.

- To expand the Video window, do one of the following:
  - Click the **Expand/Collapse** button to open it
  - Click the **Preview Video** button.
  - Click the **Video** button.
- If the **Participant** does not wish to view a **Video**, he/she can collapse the display by clicking the **Expand/Collapse** button again.
  - When the Video button is collapsed, incoming Video is not transmitted.
  - Collapsing the Video button to discontinue incoming Video from transmitting helps to reduce the bandwidth used.
  - Reducing the bandwidth will help to improve overall responsiveness.
- When **Video** is being transmitted, the **Participants** and **Moderator** will see the Participants profile picture, default profile icon, or the Video transmission.
- The **Name** of the **Participant** will appear in the **Primary Display** window.

**Participants Panel**
This is the control center of ClassLive. It is used for conducting a session within the program. It is in this area where Participants are managed by granting and revoking permissions, inviting or removing Participants to or from the session, sending them to breakout rooms, and getting their input through polling. This is also the area where user profiles of the Moderator and Participants can be viewed.

**Participants Panel Components**
The illustration and table below explain the different parts of the Participants Panel.
<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Indicators</td>
<td>These indicators appear next to the name of each Participant. They indicate what type of activity the Participant is using.</td>
</tr>
<tr>
<td>Expand/Collapse Button</td>
<td>This button is used to expand or collapse the Participants Panel.</td>
</tr>
<tr>
<td>Feedback Menu</td>
<td>To select an emoticon to display in the message, click this button. A gallery of available emoticons will display.</td>
</tr>
<tr>
<td>Global Options Menu</td>
<td>To change Chat options for Participants, click this button. A menu of options will display.</td>
</tr>
<tr>
<td>Participant Options Menu</td>
<td>This menu is similar to the Global Options Menu. However, it grants individual permissions to Participants. The option will apply only to the selected Participant, not all Participants. To access this menu, move the mouse pointer over the Participants Name.</td>
</tr>
<tr>
<td>Participants List</td>
<td>This is the area where the list of Participants and Moderators will appear. Status icons will appear beside each of the names.</td>
</tr>
<tr>
<td>Permission Indicators</td>
<td>These are the buttons that appear next to the words Main Room at the top of the Participants List. These permissions are granted by the Session Moderator. A red X will appear in the upper left corner of the icon to indicate permission has not been granted for that module.</td>
</tr>
<tr>
<td>Polling Response Menu</td>
<td>To respond to a poll, click this button. The three options are Yes, No, or None.</td>
</tr>
<tr>
<td>Raise Hand Button</td>
<td>Sometimes it is necessary to ask permission to speak or respond to something during a Chat session. When that is necessary, select this button.</td>
</tr>
<tr>
<td>Status Area</td>
<td>This area displays the Moderators or Participants name along with other status data about the person.</td>
</tr>
<tr>
<td>Step Away Button</td>
<td>Select this button when it becomes necessary to step away from the Chat for a few minutes.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>The buttons that allow a Participant to respond to different Chat options appear on this Toolbar.</td>
</tr>
</tbody>
</table>

**Moderator Privilege**

Moderator privileges can be granted to one or more Participants. These privileges can be granted at any time during the session. When Participants are granted Moderator privileges, they will have the same access to features as the Moderator of Record (Original Moderator). This includes the ability to grant Moderator privileges to other Participants. The only privilege that these Moderators don’t have is the ability to remove privileges from the Moderator of Record.

**Grant Participants Moderator Privilege**

- Select the Participant or Participants who are to be granted Moderator privileges in the Participants List.
- Do one of the following:
Drag and drop the selected Participant(s) into the Moderator section of the Participants List.

Click the Tools Menu, select Moderator, and then select Give Moderator Privileges.

On a Windows computer, right-click on the selected Participants name to open the Participants Option Menu and then select Give Moderator Privileges.

On a Mac computer, Control-Click on the selected Participants name to open the Participants Option Menu and then select Give Moderator Privileges.

The Give Moderator Privilege confirmation dialog box will open (see below).

Click Yes to grant the Participant the Moderator privilege.

Participants will receive a confirmation message that indicates that Moderator privilege has been granted.

The Participants List will be updated for all Participants indicating the change in status.

If a Moderator leaves a session, the remaining Moderators can still continue.

The disconnected Moderator can reenter the session at any time.

If all Moderators are disconnected from the session, other Participant permissions may be removed. This depends on the session configuration.

To re-establish the session, the Moderator of Record must re-connect to the session.

Raise/Lower Hand

Moderators and Participants may lower or raise their hand anytime during a session. The Hand icon will appear next to Participant names when they raise their hand. When a hand is raised by a Participant, their name will go to the top of the list, directly under the Moderators list.

Raise/Lower Hand

A Participant can raise their hand by doing one of the following:

Click the Raised Hand button as shown in the illustration at the right.

On a Windows computer, use the keyboard combination Ctrl + R.

On a Mac computer, use the keyboard combination Command-R.

A Participant can lower their hand by doing one of the following:

Click the Raised Hand button as shown in the illustration at the right.

Click the Participants Option Menu (see illustration bottom right) and then select Lower Hand.

On a Windows computer, use the key combination Ctrl + R.

On a Mac computer, use the key combination Command-R.

Raised Hand Notification

When a Participant raises their hand, the Moderator may be notified in one or both of the following ways.
A red hand icon will appear over the profile of the Participant who raised his/her hand as shown in the illustration at the right.
☆ A number will appear next to the raised hand.
☆ This indicates the order in which the Participants raised their hands.

An **Audible Notification** may be played.
☆ Audible Notification Preferences may be configured to play one sound when the Moderator raises his/her hand and another sound when a Participant raises his/her hand.
☆ The Audible Notification may be configured so a sound does not play at all.

**Step Back**
This feature is used to let others in the session know that you are temporarily unavailable. The Participant will still be connected to the session and can see and hear everything that is going on. It just means that a Participant won’t be available for interaction with other Participants.

**Step Away**
To **Step Away** from the session, do one of the following:
☆ Click the **Step Away** button (see illustration at right) on the Participants Panel.
☆ Click the **Tools Menu**, select **Interaction**, and then select **Step Away**.
☆ On a Windows computer, use the key combination Ctrl + Shift + A.
☆ On a Mac computer, use the key combination Command-A.

The **Step Away** indicator as shown in the illustration at the right, will appear next to the **Participant’s Name** in the Participants List.
The indicator will also appear next to the **Participant’s Name** in the Status area at the top of the Participants Panel.

**Step Back**
To **Step Back** into the session, do one of the following:
☆ Click the **Step Away** button (see illustration at right) on the Participants Panel.
☆ Click the **Tools Menu**, select **Interaction**, and then unselect **Step Away**.
☆ On a Windows computer, select **Interaction**, and then use the key combination Ctrl + Shift + A.
☆ On a Mac computer, use the key combination Command-A.

**CHAT**
The Chat Panel is used to exchange text messages with others in the session. The following components are available in this window.

<table>
<thead>
<tr>
<th>Tools</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Expand/Collapse Button</strong></td>
<td>This button is used to expand or collapse the Chat window. When the button is selected, just the Message Text Box will display.</td>
</tr>
<tr>
<td><strong>Message Text Box</strong></td>
<td>Type a message into this box and then press Enter to display the message for others in the session. The message will display in the Conversation Pane.</td>
</tr>
<tr>
<td><strong>Options Menu</strong></td>
<td>This menu allows the Moderator to send an announcement to everyone in the session. It can also be used to change the font size, to show Private conversation tabs, plus other options.</td>
</tr>
<tr>
<td>Tools</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Conversation Pane</td>
<td>This pane is the area where the conversations with the session Participants will display. The time the message was posted will display next to the response.</td>
</tr>
<tr>
<td>Emoticon Menu</td>
<td>To display an emoticon into the message, select this option. A gallery of different emoticons will display.</td>
</tr>
<tr>
<td>Conversation Tabs</td>
<td>When participating in a Chat, it is possible to take part in more than one conversation at a time. These conversations take place in Conversation Tabs. When Chat is activated two tabs will appear; one for messages sent to everyone (Room) and one for private conversation between Moderators. Tabs are added as more private Chat sessions are added.</td>
</tr>
</tbody>
</table>

When a participant starts to enter a message, a blue Chat activity indicator will appear next to that person’s name in the Participants List.

**View Chat Messages**

- When new messages are submitted for Chat, they will appear at the bottom of the Chat Conversation Panel.
- To read messages scroll back and forth within the Conversation Pane.
- If the scroll thumb is at the bottom of the scroll bar (the last message is visible), the Conversation Pane will scroll as new messages are received.
- If you have scrolled back to review earlier messages, the Conversation Pane will not scroll to display a new message. You must scroll to the bottom of the Conversation Pane to display the new message.
- When you are not in a conversation when a new message arrives, a New Message Indicator will appear in the tab of that conversation. To read the message, click on the tab.
**Conversation Tabs**
- It is possible for a Participant or Moderator to participate in More than one Chat conversation at a time.
- Each Conversation takes place in a separate Conversation tab.
- Two Conversation tabs will appear at the bottom of the Chat Panel when a Conversation Session begins.

- When Private Conversations are initiated, a new Conversation tab will be added to the bottom of the Chat Panel for each Conversation.
- When there isn’t any room for more Private Conversation Tabs, new Conversations tabs will be added to a list on the right side of the Chat Panel. To open the list, click on the double arrow.

**NOTE:**
- When a new Chat Message is posted within a Conversation in which you are not currently participating a New Message Indicator will display in the tab.
- The sending and receiving of Private Chat Messages is not supported on Mobile Devices.

**Move Between Conversations**
With Chat it is possible to move between conversations by clicking on the Conversation Tabs or double-clicking on the name of the person with whom you are conversing. This will allow you to view all the messages that were posted while you were away.

**Send Chat Messages**
The following types of messages can be send using Chat. Chat messages can be either typed or material may be copied and pasted from other programs, links to Web sites may be entered, and emoticons can be added.

**Send Messages to Everyone in Room or Existing Group Conversation**
- Click the Room Tab to which the message is to be added.
- Place the mouse pointer/cursor into the Message Text Field by doing one of the following:
  - Click anywhere in the Message Text Field.
  - Press the key combination Ctrl+M (Command M on Mac).
- Input your text into the Message Text Field. The Message may be typed or copied and pasted from an external source.
- Press the Enter key to send the Message.
- The Message will appear in the Conversation Pane.

**Send Messages to Selected Individuals**
Private Chat Messages can be sent to specific individuals or to a group of people. These messages will appear to you and those who were selected in the Participants List. The one exception is when a session is supervised. In these sessions, Moderators will see the private messages of all participants.
To initiate the Message, do one of the following:

- **Send to One Person-Method 1** – Double-click on the name of the person in the Participants List.
- **Send to One Person-Method 2** – Select the name of the person in the Participants List and then select Send a Private Chat from their Participant Option Menu.
- **Send to Multiple People** – Select the name of the people in the Participants List, right-click on the highlighted names. The Participants Option Menu will display. Click the Send a Private Chat option.

Enter the text in the Message Text Field. The text can be entered into the textbox or copied and pasted from an external source.

Press Enter to send the Message.

- When the Message is sent, a new Conversation Tab will open in the Chat Panel.
- The recipient of the Message will see a new Message Indicator.
- To send another Message, click on the new tab.

**TIP:**
- Don’t click on the Participant Option Menu for an individual participant.
- If the Menu for an individual participant is selected, all other participants will be unselected.

**Add Emoticons to Chat Message**

Emoticons are special graphical icons that can be inserted into any text-based Chat. This will make conversations more expressive and fun.

- Click the Emoticon button on the right side of the Message Text area (see illustration below).
- A gallery of Emoticons will display (see illustration below).

- Click on an Emoticon.
- The text string for the Emoticon will appear in the message.

The table below lists a few of the most popular Emoticons and their text strings.

<table>
<thead>
<tr>
<th>Emoticons</th>
<th>Icons</th>
<th>Text Strings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smiley</td>
<td>😊 or :D</td>
<td>:) or :-)</td>
</tr>
<tr>
<td>Wink</td>
<td>😏 or 😘</td>
<td>;) or ;-)</td>
</tr>
<tr>
<td>Sad</td>
<td>😞</td>
<td>:( or :-</td>
</tr>
<tr>
<td>Surprised</td>
<td>😮 or 🤔</td>
<td>:-o or :-O</td>
</tr>
<tr>
<td>Confused</td>
<td>😳 or 😞</td>
<td>:/ or :-/</td>
</tr>
<tr>
<td>Grin</td>
<td>😊</td>
<td>:D or :-D</td>
</tr>
</tbody>
</table>
Emoticons | Icons | Text Strings
--- | --- | ---
Angry | 😞 | :@ or :-@
Thumbs Up | 👍 | (y)
Thumbs Down | 😞 | (n)

**NOTE:**
- If the Chat Emoticons menu does not appear, this means the Moderator has disabled this feature.
- The text string equivalents of Emoticons can be input into the message, however, they will not be converted to icons when the Message is viewed.
- Emoticon text strings are not case sensitive. This means they can be input in either upper or lower case letters.

**Add External Links to Chat Message**
HTTP links can be included in Chat Messages. This can be done by typing the link directly into the Chat Message. They can also be copied and pasted or dragged and dropped from a browser or email message. Message recipients will be able to click on the links to open the Web sites in their default browsers. The table below shows the types of links with examples of what can be used in a Chat Message.

<table>
<thead>
<tr>
<th>Link Type</th>
<th>Syntax</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP Web Site</td>
<td>http://</td>
<td><a href="http://www.sienaheights.edu">http://www.sienaheights.edu</a></td>
</tr>
<tr>
<td>Secure HTTP Web Site</td>
<td>https://</td>
<td><a href="https://www.sienaheights.edu">https://www.sienaheights.edu</a></td>
</tr>
</tbody>
</table>

**Enter Feedback**
Feedback options can be selected by Participants from the Feedback Menu or by using keyboard shortcuts. They are used to express common reactions to a presentation or a message. The emoticon will appear next to the Moderators or Participants name in the Participants List.
- To select the Feedback Options, do one of the following:
  - Click the Feedback Menu Button (see illustration at right) on the Participants Panel. Select an emoticon from the gallery that displays.
  - Click the Tools Menu, select Interaction, select Show Emotion, and then select an emoticon from the gallery that displays.
  - Enter the appropriate keyboard shortcut as shown in the table below.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Emotion</th>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎭</td>
<td>Show Smiley Face</td>
<td>Alt + 1</td>
<td>Option-1</td>
</tr>
<tr>
<td>😻</td>
<td>Show LOL</td>
<td>Alt + 2</td>
<td>Option-2</td>
</tr>
<tr>
<td>🎉</td>
<td>Show Applause</td>
<td>Alt + 3</td>
<td>Option-3</td>
</tr>
<tr>
<td>🤔</td>
<td>Show Confusion</td>
<td>Alt + 4</td>
<td>Option-4</td>
</tr>
<tr>
<td>🎉</td>
<td>Show Approval</td>
<td>Alt + 5</td>
<td>Option-5</td>
</tr>
<tr>
<td>🙄</td>
<td>Show Disapproval</td>
<td>Alt + 6</td>
<td>Option-6</td>
</tr>
<tr>
<td>⏪</td>
<td>Show Slower (presenter needs to slow down)</td>
<td>Alt + 7</td>
<td>Option-7</td>
</tr>
<tr>
<td>⏫</td>
<td>Show Faster (presenter needs to speed up)</td>
<td>Alt + 8</td>
<td>Option-8</td>
</tr>
<tr>
<td>🟨</td>
<td>Blank Square - Show None (This will clear all displayed feedback icons)</td>
<td>Alt + 9</td>
<td>Option-9</td>
</tr>
</tbody>
</table>

**Content Area Modes**

This area enables the moderators and participants to exchange information with others using the features listed in the table below. These features share space in the Content Area. Each one represents a mode. It is only possible to see the content of one mode at a time.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Whiteboard</strong></td>
<td>❌ This feature is used to share presentations and drawings with other session participants.</td>
</tr>
<tr>
<td></td>
<td>❌ This mode is persistent, which means it will still be available when you move to a different mode and then return to the Whiteboard.</td>
</tr>
<tr>
<td></td>
<td>❌ This is the default mode when ClassLive is activated.</td>
</tr>
<tr>
<td><strong>Application Sharing</strong></td>
<td>❌ To share individual software applications or the entire desktop with other session participants, select this feature.</td>
</tr>
<tr>
<td></td>
<td>❌ This mode is persistent. Which means it will still be available when you move to a different mode.</td>
</tr>
<tr>
<td></td>
<td>❌ Resume Sharing must be selected when returning to this mode from a different mode.</td>
</tr>
<tr>
<td><strong>Web Tour</strong></td>
<td>❌ Select this option to share Web pages with others in the session.</td>
</tr>
<tr>
<td></td>
<td>❌ This mode is not persistent.</td>
</tr>
<tr>
<td></td>
<td>❌ Content for this mode will have to be reloaded each time you switch between modes.</td>
</tr>
</tbody>
</table>

**Switch Modes**

- Only certain users can switch between the different modes.
- When modes are switched, everyone in the session is switched to that mode.
- Moderators can switch between all modes.
- Participants with Application Sharing permission can switch to Application Sharing mode and back to Whiteboard mode.
- Participants with Web Tour permission can switch to Web Tour and back to Whiteboard mode.
- Participants who have only Whiteboard permission are not able to switch to Whiteboard mode from Application Sharing or Web Tour. This prevents Participants
from inadvertently switching modes during someone else’s Web Tour or Application Sharing presentation.

To switch modes, Participants can do one of the following.
- Click on the button on the Collaboration Toolbar with the desired mode (see the illustrations in the table above).
- Select the desired mode from the View Menu (see illustration on previous page).
- Use the keyboard shortcut associated with the desired mode.
  - **Whiteboard Mode** – Windows: Ctrl + Alt + W
    Mac: Command-Option-W
  - **Application Sharing Mode** – Windows: Ctrl + Alt + A
    Mac: Command-Option-S
  - **Web Tour Mode** – Windows: Ctrl + Alt + U
    Mac: Command-Option-U

**Whiteboard Mode**
This is the default mode for ClassLive. In this area, it is possible to write text with the pencil tool, to draw shapes with either the filled or empty shape tools, to draw lines with the line tool, to insert screen captures or clipart images, to highlight areas of the window, or to input text with the text editor.

**Whiteboard Tools Palette**
This palette contains drawing and text tools. These tools can be used to create and manipulate objects in the Whiteboard workspace. Tools are available to place screen captures and clipart images on the Whiteboard.

Additional optional tools are available for the items where a tab appears in the lower right corner. To access these tools, click and hold or double-click the left mouse button. The option selected will depend on the operating system being used. These tools are available if Whiteboard tools permission has been granted by the moderator.

The table below provides an image and description of each of the tools on this palette.

<table>
<thead>
<tr>
<th>Tools</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selector Tool</td>
<td>To select objects within the Whiteboard, select this tool. Once the tool is selected, click and drag to draw a box around the item(s) that are to be selected.</td>
</tr>
<tr>
<td>Pointer Tools</td>
<td>This tool is used to point to different objects on the Whiteboard. A gallery of different types of pointers, as shown in the illustration, will display when the triangle in the bottom-right corner of the tool is clicked.</td>
</tr>
<tr>
<td>Tools</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Pencil Tool</strong></td>
<td>Select this tool to write or draw on the Whiteboard. Click the tool once to select and then the second tool (see below) to activate the pencil tool. Click the triangle in the lower right corner to display the Properties Editor as shown in the illustration.</td>
</tr>
<tr>
<td><strong>Text Editor Tool</strong></td>
<td>To add text to the Whiteboard, select this tool. The Simple Text button (shown at left) is used to enter a Label on the page. the Properties Editor as shown in the illustration will display. The Text Editor Tool (see below) is used to enter text on the page.</td>
</tr>
<tr>
<td><strong>Filled Shape Tools</strong></td>
<td>This tool is used to insert filled shapes into the Whiteboard area. Two different shapes (ellipse and rectangle) can be drawn. When the shape is selected, the Properties Editor as shown in the illustration will display.</td>
</tr>
<tr>
<td><strong>Empty Shape Tools</strong></td>
<td>Select this tool to insert a shape outline into the Whiteboard. An ellipse and rectangle can be drawn using this tool. When the shape is selected the Properties Editor as shown in the illustration will display.</td>
</tr>
<tr>
<td><strong>Line Tool</strong></td>
<td>To draw a straight line on the Whiteboard, select this tool. The Properties Editor as shown in the illustration will display when the tool is selected.</td>
</tr>
</tbody>
</table>
| **Screen Capture Tool**| This tool is used to capture the screen of the most recently used program on the computer and display it on the Whiteboard. Portions of the screen can be captured by moving the mouse pointer to the corners of the capture.  
When the mouse pointer changes to a two-headed arrow, move the mouse to remove portions of the capture. To move the capture area around the window, move the mouse pointer to the edge of the capture area until the mouse pointer changes to a four-header arrow and then drag the capture to the area that is to be captured. |
Tools | Description
--- | ---
Clipart Tool | Select this tool to insert a clipart image on the Whiteboard. A gallery of different images will appear when this option is selected. Click one of the tabs to view different types of images.

Note:
- If two or more different kinds of tools are selected the Properties Editor will display only the attributes common to all the tools.
- When a color is selected in the Properties Editor, click outside the color palette once to close it and then click a second time to start the drawing.

Add External Content
There are a number of different file types that can be loaded into the Whiteboard as Whiteboard pages such as Whiteboard files, image files, PowerPoint presentations, and Open Office presentations. Files can be loaded using the Page Explorer or File Menu.

Supported Content Types
The following content types can be used with the Whiteboard.
- Image Files - .gif, .jpg, .jpeg, and .png files
- Whiteboard Files - .wbd files
- Protected Whiteboard Files - .wbd files
- PowerPoint Files - .ppt and .pptx
- Open Office Files - .ppt, .pptx, .sxi, and .odp

Insert Content
- Select the File Menu.
- Move the mouse pointer over the Open option.
- Click the Whiteboard option.
- The Load File window will display (see illustration below).
- Select the file that is to be added.
- Click Open.
  or
- Click the Open Navigation Option Button (see illustration).
- The Page Explorer window will display (see illustration next page right).
- Right-click on the page after which the new page is to be added.
- Select Open from the Content Menu.
- The Load File window will display (see illustration next page left).
- Select the file that is to be added.
- Click Open.
Note:
- If a PowerPoint or Open Office file is uploaded, the Converting File window will display (see illustration on next page).
- This window shows the progress of the conversion.
- Each presentation slide will be loaded as a separate Whiteboard page as a static image.
- The title for each slide will appear as the page name.

Insert Text
There are two text tools available. The Simple Text tool creates text as an object directly on the Whiteboard. The text can be manipulated just like a shape or image in a graphic design program. The Text Editor creates a bounding box for the text. The text inside the box can be edited as in a Word document or a Publisher document.

Use the Simple Text Tool
- Click the Simple Text tool on the Tools Palette (image on right).
- On the Tools Palette, click and hold the Text Editor tool (image on left).
The tool should expand and display the **Simple Text** tool (image on right).
The **Properties Editor** will display.

In the **Editor**, select the font name, color, size, bold, underline, and/or italics.
Click the Whiteboard to place an insertion point.
Type the text.
Press **Enter** when all the text has been entered.

**NOTE:**
- Only one line of text can be entered in the Simple Text box.
- Line breaks cannot be inserted.
- The text does not automatically wrap to the next line when it reaches the edge of the Whiteboard page.
- When Enter is pressed, a new Simple Text box will appear in the Whiteboard window.

**Use the Text Editor Tool**
- Click the **Text Editor** tool (image at left).
  or
- On the **Tools Palette**, click and hold the **Simple Text** tool (image on right).
  The tool should expand and display the **Text Editor** tool (image on left).
  Single-click on the Whiteboard to create a text box of the default size.
  or
- Click and drag the mouse button to create a text box of the desired size.
  The **Properties Editor** will display at the bottom of the Whiteboard.

In the **Editor**, select the font name, color, size, bold, underline, and/or italics.
Input the desired text, pressing **Enter** to create a new line of text within the text box.

**NOTE:**
- The maximum number of characters for the Text Editor is 10,000.
- A scroll bar will appear on the right side of the text box if the text exceeds the space available in the text box.
- To remove the scroll bar and display all the text, resize the text box.

**Insert External Links**
External links can be inserted into the Whiteboard using either the Simple Text or Text Editor tools. When visitors access the page, they will be able to click on the link to open an Internet site or send an email.

**NOTE:**
- To enter a link in the Simple Text tool, do not enter any text except that contained in the link.
- If other text is entered, the link will not work.
- The following types of links may be inserted into the Whiteboard.
Insert Graphics
The following tools can be used to insert graphics into the Whiteboard. All of these tools are available from the Tools Palette of the Whiteboard.

<table>
<thead>
<tr>
<th>Tools</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pencil/Freehand Tool</td>
<td>Select this tool to write or draw on the Whiteboard. Click the tool once to select and then the second tool (see bottom tool) to activate the pencil tool. Click the triangle in the lower right corner to display the Properties Editor as shown in the illustration. Select the color, transparency, and line thickness from the Properties Editor.</td>
</tr>
<tr>
<td>Filled Shape Tools (ellipse and rectangle)</td>
<td>This tool is used to insert filled shapes into the Whiteboard area. Two different shapes (ellipse and rectangle) can be drawn. When the shape is selected, the Properties Editor as shown in the illustration will display. The color and transparency can be selected from the Properties Editor.</td>
</tr>
<tr>
<td>Empty Shape Tools (ellipse and rectangle)</td>
<td>Select this tool to insert a shape outline into the Whiteboard. An ellipse and rectangle can be drawn using this tool. When the shape is selected the Properties Editor as shown in the illustration will display. The color, transparency, and line thickness can be selected from the Properties Editor.</td>
</tr>
<tr>
<td>Line Tool</td>
<td>To draw a straight line on the Whiteboard, select this tool. The Properties Editor as shown in the illustration will display when the tool is selected. The Properties Editor can be used to select the color, transparency, and line thickness.</td>
</tr>
</tbody>
</table>

NOTE:
- To draw a horizontal, vertical, or 45 degree angle line, hold down the Shift key while drawing the line.
- Which line is drawn will depend on the direction the line is drawn.
- To draw a circle, hold down the **Shift** key while drawing an ellipse.
- Hold down the **Shift** key while drawing a rectangle to draw a square.
- When a color is selected in the Properties Editor, click once to close the palette and a second time to start drawing.
Insert Clip Art Images
Clip art images can be loaded from the Clip Art Library of presentation and mathematical symbols.

 Click the Insert Clip Art button in the Tools Palette.
 The Clip Art bar will display with the Common Symbols tab selected (see below).

Select one of the tabs that contains the clip art that is to be inserted.
Hover the mouse over the image to see a description of the image.
Single-click on the desired image.
Move the mouse into the desired position on the Whiteboard.
Click on the Whiteboard to anchor the image into position.

Insert Clip Art Background Image
 Click the Insert Clip Art button in the Tools Palette.
 The Clip Art bar will display (see previous page).
 Select the Backgrounds tab, if necessary.
 Select an image from the gallery that appears.
 The image will be inserted into the background of the Whiteboard page.
 The image cannot be edited or moved.

Insert Clip Art Image as Stamp
Clip Art images can be used as stamps. This means they can be inserted over and over again into the Whiteboard page.
 Click the Insert Clip Art button in the Tools Palette.
 The Clip Art bar will display (see previous page).
 Select the tab that contains the image that is to be inserted.
 Double-click the image that is to be inserted.
 The cursor will change to a stamp icon.
 Click on the Whiteboard page in as many places as desired.
 To turn the stamp off, do one of the following:
  ◆ Press the Esc key on the keyboard.
  ◆ Click on another image in the gallery.
  ◆ Click on one of the other tools on the Tools Palette.

Insert Screen Capture
This tool is used to insert an image of a portion of a desktop, an application, or Web site. The image will then be loaded into the Whiteboard. It is not possible to take an image of the ClassLive application windows.
 Click the Insert Screen Capture button on the Tools Palette.
 A transparent frame will appear with four buttons in the middle.
Click inside the frame and drag it into position on the screen to enclose the desired area.

- To resize the frame, move to the corners of the frame until the cursor turns to a two-header arrow and drag to the desired position.
- Switching between programs or performing other tasks on the computer may cause the frame to stop updating.
- Click Refresh to manually update the frame if this should occur.

Do one of the following:

- Select OK to capture exactly what is enclosed in the frame at that moment.
- Select With Delay to add ten seconds before the frame is captured.
  - This provides time to position the cursor or other features that must be maintained with the mouse in order to be captured.
- Click the Cancel button to close the frame without capturing an image.

Once the image is captured, it will appear in the Whiteboard.

- The image can be positioned on the board by dragging it to a new location.
- Click the Whiteboard region to anchor the image in position.

**Point to Items on Whiteboard**

To draw people’s attention to an item on the Whiteboard, the Pointer Tools can be used.

- Click and hold the Pointer tool.
- A group of available pointers will display.
- Click the desired Pointer.

Do one of the following so others will see the Pointer as you move around the Whiteboard.

- Hold down the left or right mouse button as you move the pointer.
- Release the mouse button to stamp the pointer image on the Whiteboard.
  - or
  - Double-click anywhere on the Whiteboard to get the mouse pointer to follow the mouse motion without having to hold the mouse button.
- Move the mouse around the board.
- To release this mode, click with the mouse again or select a different tool.

If one of the above is not done, the pointer will be visible to only you.

**Application Sharing**

This feature is used to share applications or the entire desktop with participants in the Chat Session. It is a type of content that appears in the Content area like the Whiteboard and Web Tour. When someone is hosting an Application Sharing session the blue Application Sharing Activity Indicator (see illustration at right) appears next to their name in the Participants List.

The Session Moderator must provide Application Sharing permission before a Participant can access it. If permissions have not been granted, the Participant will only be able to view Application Sharing, but will not be able to share an application.

Users of Mobile Devices cannot host or remotely control Application Sharing sessions. They are only able to view them. The user has to log in to the session from a desktop or laptop computer in order to host an Application Sharing session.
View Shared Application
Application Sharing is displayed in the Content Area. This area contains an Application Sharing Action Bar in the upper left corner. If Participants do not have Application Sharing permission they will only see the Scale to Fit option. Participants who have Application Sharing permission will see the Scale to Fit and Request Cursor Control options.

- **Scale to Fit** – This feature allows Participants to scale the window so they can view the content at the same size as the Host/Moderator.
- **Request Cursor Control** – This feature allows the Participant to take control of the desktop of the Host/Moderator. The Participant will then be able to control the cursor. The Moderator has to grant the Participant to take control of the cursor.

Scale Shared Content
The application or desktop area that has been shared by the Host/Moderator can be scaled to fit the Content Area or viewed at the same size as the Host/Moderator. To view the content at the same size as the Host/Moderator, do one of the following:
- Uncheck **Scale to Fit** in the **Action Bar**.
- Click the **Tools Menu**, select **Application Sharing**, and then uncheck **Scale to Fit**.
- To restore scaling to the default, recheck **Scale to Fit**.

Maximize Content Area
There are two ways in ClassLive Pro to maximize the content area of a session.
- **Maximize Window** – To maximize the window, click the **Maximize** button in the upper right corner of the ClassLive window.
- **Hide Side Bar** – To hide the side bar, unselect Show Side Bar in the View Menu or move the mouse pointer over the right edge of any of the panels until it turns to two solid lines with two arrows. Drag the panel to the left.

Host Application Sharing Session
Before an Application Sharing session can be conducted, the Participant must be granted Application Sharing permission by the Moderator and must switch to Application Sharing Mode in the Content area. When switching modes, the Participant needs to be careful not to inadvertently switch modes on someone else. If that happens, everyone in the session will follow the Participant to the new mode.

Switch to Application Sharing Mode
Do one of the following to switch to Application Sharing:
- Click the **Application Sharing Mode** button in the **Collaboration Toolbar** (see illustration at right).
- Click the **View Menu** and then select **Application Sharing**.
- On a **Windows** computer, enter the keyboard combination **CTRL + Alt + A**.
- On a **Mac** computer, enter the keyboard combination **Command-Option-A**.
- Click the **Tools Menu**, select **Application Sharing** and then select **Start Sharing**.
Click the **Tools Menu**, select **Application Sharing**, and then select **Share Entire Desktop**.
- Application Sharing will be started immediately.
- The **Available Sharing Selection** dialog box will not display.

When the **first five options** are used to start Application Sharing, the **Available Sharing Selections** dialog box will open.

Start an Application Share
- In the **Available Sharing Selections** dialog box, do one of the following:
  - Click **Share Desktop**.
  - Click one of the available programs.
    - If there are multiple available windows for a program, click the arrow icon (see illustration) to expand the list.
    - Select the window that is to be shared.
    - To share multiple applications or windows, select them by using the Shift or Control button.
- Click **Share** to begin sharing the Application.
- Click **Cancel** to close the menu without sharing an application.
- To start a new share after cancelling, click the **Start Sharing** button on the **Action Bar** (see illustration).
- Move the window that is to be shared to the front of the desktop.
  - Obscured windows or portions of windows will not be visible to remote Participants.

**TIP:**
- A helpful approach is to resize the window that is being shared to the dimensions of the Content area.
- This will allow the Participant and the Host to have access to all Blackboard Collaborate Web Conferencing Tools even while sharing the application.

**NOTE:**
- The Application will persist until it is closed or when the host leaves the session.
- If the Participant switches to Whiteboard or Web Tour mode, the share will still be active, but not visible.
When the Participant switches back to Application Share the application will be visible.

**Pause Application Share**
An Application Share that has been paused can be easily restarted later. Complete one of the following steps to pause an Application Share.

- Click **Pause Sharing** in the Action Bar.
  - If the **Hosting Preference Hide Content** is not turned on, the Action Bar will not be visible.
- Click the **Tools Menu**, select **Application Sharing**, and then select **Pause Application Sharing**.
- Switch to either **Whiteboard Mode** or **Web Tour Mode**.

**Resume Application Share**
Complete one of the steps below to resume Application Sharing.

- Click **Resume Sharing** in the Action Bar.
- Click the **Tools Menu**, select **Application Sharing**, and then uncheck **Pause Application Sharing**.

**Preview Application Share**
A small preview window of the shared application can be viewed by the host. This allows them to see how the application or desktop appears to others. It allows hosts to know if part of a shared window is obscured or if the application share becomes frozen or lost.

- Click the **Tools Menu**.
- Select **Application Sharing** from the list of options.
- Click **Show Preview**.
- A preview of the application will appear in the upper-left corner of the program window.

**Give Control to Another Participant**
With this option, Application Sharing Hosts can turn control of their application or desktop over to another Participant. The Participant who has remote control can move the mouse cursor, click and type. The host retains control at all times and can revoke control at any time. Only the host and one other Participant can share control at one time.

- There are two ways that a shared application or desktop can be controlled by another Participant.
  - Control can be delegated to them.
  - Control can be requested from the Participant. The host can reject or approve the request.
- If control is delegated to a Participant, the Participant does not need Application Sharing permission to take control.
- When an Application Window or Desktop is being shared, the remote Participant’s control is limited only to the selected application.
- The Participant doesn’t have access to other areas of the Host’s desktop.

**CAUTION:**

- When giving Remote Control Access to the desktop of a computer, be very careful.
- The Remote Controller has full user control over the computer.
- It is imperative that the Host not leave the computer unattended.

**Delegate Remote Control**

- On a **Windows** computer, right-click on the **desired person** in the **Participants List**.
Select Give Control of Shared Applications.  

or  

On a Mac computer, Control-Click on the desired person in the Participant’s List.  

Select Give Control of Shared Applications.  

or  

Open the Participants Option Menu of the desired person in the Participants List.  

Select Give Control of Shared Applications.  

or  

Select the desired person in the Participants List.  
☆ Click the Tools Menu.  
☆ Select Application Sharing.  
☆ Select Give Control of Shared Applications.  
The person with Remote Control will have joint control over the cursor until the permission is revoked or until they voluntarily end their control.  

Grant Request for Control  
Moderators and Participants who have been granted Application Sharing permission have the ability to request control of a shared application or desktop. When a control is requested, a Remote Control Requested dialog will appear on the Moderator screen.  
☆ Click Yes to allow a participant one time access to the desktop.  
☆ Check Allow all other requests until I quit, to allow future requests for control from any Participant without requiring approval. This setting will last until the Host exits the session.  
☆ To require a Participant to request control, enter the password in the field below the Allow all requests until I quit option.  
☆ To deny access to the desktop one time, click the No button.  

CAUTION:  
☆ When giving Remote Control Access to the desktop of a computer, be very careful.  
☆ The Remote Controller has full user control over the computer.  
☆ It is imperative that the Host not leave the computer unattended.  

Stop an Application Share  
Complete one of the steps below to stop an Application Share.  
☆ Enter the keyboard Control + Shift + S on a Windows computer.  
☆ On a Mac computer, enter the keyboard shortcut Command-Shift-S.
Click **Stop Sharing** on the **Action Bar**.

* If the **Hosting Preference Hide Content Area** is turned on, the **Action Bar** will not be visible.

Click the **Tools Menu**, select **Application Sharing**, and then select **Stop Sharing**.

**WEB TOUR**

This feature can be used to share Web pages with others in the session. It is a type of content that appears in the Content Area and is accessed through the Collaboration Toolbar. This feature is not supported on mobile devices. Students must be granted Web Tour permission by the Moderator before they can share a Web page. If students have not been granted Web Tour permission they are only able to view Web pages displayed by the Moderator.

**Switch to Web Tour Mode**

One of the following ways can be used to connect to Web Tour Mode.

- Click the **Web Tour Mode** button on the **Collaboration Toolbar**.

- Click the **View Menu** and then select **Web Tour**.

- On a **Windows** computer, use the keyboard shortcut **Ctrl + Alt + U**.

- On a **Mac** computer, use the keyboard shortcut **Command-Option-U**.

- The following components are available when in the Web Tour interface.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collaboration Toolbar</td>
<td>This is the area that contains the buttons that are used to move from Whiteboard, to Application Sharing, to Web Tour Modes</td>
</tr>
<tr>
<td>Navigation Bar</td>
<td>To move around in the Web site or to access a different site, click the options on this bar.</td>
</tr>
<tr>
<td>Back/Forward Buttons</td>
<td>Click these buttons to move back and forth in the Web site.</td>
</tr>
<tr>
<td>Address Text Box</td>
<td>This is the area where the address for the Web site is input. Once the address has been input press the Enter key to access the page.</td>
</tr>
<tr>
<td>Follow Me Option</td>
<td>This option allows Participants to freely browse other pages in the Web Tour, independent of the pages to which the tour guide browses.</td>
</tr>
<tr>
<td>Options Menu</td>
<td>To decide how the Web page is to be viewed, click this option. The two options are Publish the URL to Chat or Open the URL in the browser.</td>
</tr>
</tbody>
</table>
When someone is hosting a Web Tour, the blue Web Tour Activity Indicator will appear next to their name in the Participants List.

Start Web Tour
The Moderator as well as Participants, if permission has been given, can start a Web Tour. To start a Web Tour, complete the steps below.
- Enter the **URL/Address** of the Web site in the **Address** box on the **Navigation Bar** (see illustration below).

![Navigation Bar](image)

- Press the **Enter** key on the keyboard.
- To allow others to freely browse the Web site independent of the pages the host is accessing, uncheck the Follow Me button.

Conduct Web Tour
- To navigate through the current Web site within Web Tour, it is possible to click on the links in the site.
- To move to a different site, enter a new URL/Address in the Address text box.
- When browsing the site, Web Tour maintains a history of the pages that were visited. To move between the pages kept in the history, click the Back and Forward buttons on the Navigation Bar.

**NOTE:**
- Web Tour cannot be used for password-protected sites. If password-protected sites are used in Web Tour, Participants will not be able to follow the Host past the login screen.
- Password-protected sites can be shared using Application Sharing. This will allow the Participants to view the Host’s desktop or Web browser.

Follow Me Option
- This option is selected when switching to Web Tour mode.
- When this option is selected, session attendees will be able to freely browse to other pages in the Web Tour.
- This is independent of the pages which the Tour Guide browses.
- When the Tour Guide moves to a new page, the Participants will be redirected to the new page.
- Participants are not able to follow the Tour Guide to a different page if the Web page is protected by a password. An error will display such as **The Web page cannot be found.**
- To prevent the Participants from being directed to the new page, unselect the **Follow Me** option.

Tour Guide Control
- The person starting the **Web Tour** is automatically the **Tour Guide**.
- A Moderator or Participant with Web Tour permission can take control of the Web Tour by selecting the **Follow Me** option.
- The Tour Guide’s **Follow Me** option will be unselected.
The Tour Guide can take back control by selecting **Follow Me** again.

**Publish URL/Address to Chat Panel**
Moderators and Participants with Web Tour permissions are able to publish the URL/Address of the active Web page to the Chat Conversation pane. This will make it available to everyone in the session.

- Click the **Web Tour Options Menu**.
- Select **Publish URL to Chat**.
- The URL/Address will be added to the **Chat Panel**.

**Stop Web Tour**
To stop the Web Tour, switch the mode to **Whiteboard** or **Application Sharing**.

**View a Web Tour**
Once a Web Tour has been started, it is possible for the Participants to navigate to other pages within the Web site. Do one of the following to navigate through the site.

- Click the **links** within the **Web site**.
- Click the **Back** and **Forward** buttons on the **Navigation Bar**.
  - If the Host has selected the **Follow Me** option, you will always be redirected to the Host’s current page whenever the Host moves to a new page.
  - It is not possible to follow the Host to a Web page that is password protected. A message such as **The page cannot be found** will display.

**Optimize Content Area**
Web Tour content may not fit into the Content area of ClassLive Pro. If that happens, Participants will have to use the scroll bars to view the Web pages. There are two ways that space can be optimized in the Content area of a session.

- **Maximize Window** – To maximize the window, click the **Maximize** button in the upper right corner of the ClassLive window.
- **Hide Side Bar** – To hide the side bar, unselect Show Side Bar in the View Menu or move the mouse pointer over the right edge of any of the panels until it turns to two solid lines with two arrows. Drag the panel to the left.
- **Restore Side Bar** – To restore the sidebar, reselect **Show Side Bar** or drag the **Panel Border** back to the right.